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Biography

Angela C. Buraglia

CEO, Site-Drive Inc.

Angela C. Buraglia used to be a makeup artist for independent film, but she left
her career for one where she could work from home and raise her son. Although
she only aspired to be a web developer, unintentionally she became that and
more. She is perhaps best known as the founder of DreamweaverFAQ.com which
she still runs today with Daniel Short.

Angela is the co-author of Macromedia Dreamweaver MX 2004 Killer Tips with
Joseph Lowery as well as a co-author of Macromedia Dreamweaver MX 2004
Magic. She is a contributing author to Macromedia ColdFusion MX 7 Web
Application Construction Kit and has been a technical editor for various
Dreamweaver titles.

Angela's future plans are to continue developing DreamweaverFAQ.com, to build
and sell Dreamweaver extensions, and to continue her involvement in
Cartweaver. Long gone are the days of applying makeup; now Angela applies her
variety of skills to web development.
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http://www.dwfaq.com/
http://www.dwkillertips.com/
http://www.dwmagic.com/
http://www.dwfaq.com/store/merchants.asp?MerchID=DreamweaverFAQ.com
http://www.cartweaver.com/

Biography

Daniel Short

CTO, Site-Drive Inc.

Dan's been doing the web gig since the end of 1998 and runs a very successful
web development company, \Web Shorts Site Design. He is also the Lead
Developer for Cartweaver, driving the development of future versions of the
product. Dan's primary focus is on dynamic development with both ASP and
ColdFusion. He has also written articles for several resource sites, such as
AListApart.com and the Macromedia Developer Center.

Additionally, he's recorded several Dreamweaver-related movie titles for the
Lynda.com Learning Library, is a coauthor of Dreamweaver MX Magic 2004, a
contributing author to the previous version from New Riders, Dreamweaver MX
Bible from Wiley Publishing, and Dreamweaver MX: Advanced ASP Web
Development from Glasshaus.

Look for Dreamweaver 8 Hands-On-Training by Daniel Short and Garo Green,
coming soon to bookstores everywhere...
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http://web-shorts.com/
http://cartweaver.com/
http://macromedia.com/devnet/

Who, What, Huh?

 Who?
— Angela C. Buraglia

 URLs You'll Find Angela: dwmommy.com (blog) DWfaqg.com,
Cartweaver.com, dwkillertips.coms

— Daniel W. Short
« URLs You'll Find Dan at: dansshorts.com (blog), DWfag.com,
Cartweaver.com, lynda.com
« What? What's New in Dreamweaver 87
— Demo as much as we can
— Hopefully teach you few things that you may not know Dreamweaver can do
— Answer questions
e Huh? confused already?! That’s alright, just put your head down, take a nap and let your

buddies fill you in later. Unlike a personal appearance | can’t see you anyhow, so my feelings
won'’t be hurt.
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Design — What's New

« Starter Pages

* Guides and Zoom

« Paste Special
 Flash Video Support
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CSS — What's New

* Unified CSS Panel
Style Rendering Toolbar

— Support for media types in Design view
CSS Layout Visualization tools
Rendering of System Colors
Absolute Paths honored for CSS

CSS display:none; improved
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CSS System Colors

* Dreamweaver 8

— renders system colors in
Design view

— no built-in interface
available

— must be hand coded

« CSS System Colors

— are case-sensitive 3| Rt |

— work in modern
browsers (Windows &
Mac)

<body>
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Example Code: CSS System Colors

« CSS system colors can be used for any property that

has a color as (part of) its value
legend{
color:CaptionText;

background-color:ActiveCaption;

}
« Syntax online: http://www.dwkillertips.com/go/18
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Absolute CSS, Absolutely!

* As of Dreamweaver 8 you may now link to CSS files with

absolute URLs and still have them render in Design view

<link href="http://[path]/[file] .css" rel="stylesheet" type="text/css"
/>

@ ...m\www\max\2005\article\absolute.htm (XHTML) LE ;"

L

4 0 50 [100 150

Pl

This file doesn't have any CSS attached to it at all. No link
tags, no style blocks, nothin', zippo, nada...There aren’t any
.cs5 files locally either. (You're going to have to trust me on
this!)

Yet, Dreamweaver's Design view is rendering styles. How can
that be?

There's a design-time CSS file pointing to: °34
http://www.dwkillertips.com/max/2005/assets/css/max.css

<body> <div#divContent> <p> @ Q, |100% + | 422x 251+ 1K [ 1sec
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Demo: Examples of Absolute URLs for CSS

 Full article available at:

http://www.macromedia.com/macromedia/events/max/sessions/sa302w.html
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Code — What's New

* Coding Toolbar — with totally new functionality
including:
— Code Collapse Functionality
— Various Comments (Add/Remove)
— Wrap Tag
— Recent Snippets

— Other new functionality hidden in commented out code in
toolbars.xml

* Context Menu functionality
— Selection submenu
— Code Hint Tools submenu

« Changes to how Code Completion works
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Miscellaneous New Stuff

« Saved Workspace Layouts
* Opening Files in the Order You Want

— Didn’t cover, but tossed in slides to make it up to you!
* Re-ordering the documents
 And more...
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Saved Workspace Layouts

¢ Save a Variety Of Code Inspector F10

Timelnes Alt+F39

workspace layouts _ vorkspace Layot 5 cos

<  Hide Panels F4 Designer
Dual Screen

+ Select the saved | [ BN e
workspace layout e
that fits the tasksat = =~ I} o
hand H= [ = o | -

Note: Workspace layouts _...“., R

only manage panels and I
the Document window, not el T
toolbars. Fiptee 2
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Open Multiple Files (in the Order You Want*)

 Ctrl+click (Cmd+click) individual noncontiguous files

 Shift+click once and then a second time to select all
files between and including the ones you selected
using Shift+click

* Windows only — The order you select the files in is the
“backwards order” that they will be opened. To get
your desired order, select the files in reverse order of
their final opened order.
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Demo: Opening Files in the Order You Want

Frrnn Results.cfm | ShowCart.cfm | Confirmation.cfm | Details.cfm

3._ CWErrorExceptmn cfm o i
- @ CWErrorRequest.cfm

@ 2 Details.cfm

Desktop 3‘—

2 OrdefForm cfm

EI

Q€ Fereme: [ndexcin® Resutscin”“ShowCa cin” Confimatoncin Detsecin’ _[w]  [_Open ]
My Network | Flesoftype: [ Al Documents ("htm:* htmi:* shtm:” shiml.~ hta:htc:”xhtml:*stm:*ssi~js:"as"as|w| [ Cancel | |k




Re-ordering Open Documents

* Click and drag the filename tabs into the order you
want!

* There isn’t a visual indicator that moving filename tabs
can be done or any sort of transparency to indicate the
same tab is being held and moved. Send your
suggestions for tab re-ordering interface to
http://www.macromedia.com/go/wish
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No RDS, No Icons...No More!

 Dreamweaver requires that a ColdFusion MX 7 testing server
with RDS access be defined in order for the new ColdFusion
MX 7 objects (circled below) to appear in the CFFORM

category
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Editing insertbar.xml — What You Should Know

 In your User’'s Configuration, locate:
Configuration\Objects\insertbar.xml

Note: If the file does not exist, copy the Program’s file to your User’s Configuration.

« Casing counts, so be careful. It is best to edit
insertbar.xml in HomeSite or other text editor besides
Dreamweaver.

* Look for the <category> tags to help you find the section
you're looking for

« Restart Dreamweaver after any changes
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How to Edit the showlf Attribute

Change:

showIf="dw.getDocumentDOM() &&
dw.getDocumentDOM () . serverModel .getServe
rVersion ('Server.ColdFusion.ProductVersi
on.Major') >= 7"

To:
showIf="dw.getDocumentDOM() "
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Surround with #

« New in Dreamweaver 8, Ctrl+Shift+3 will surround the current
selection with # symbols

 Potential “Gotcha”: HomeSite uses Ctrl+3, but this is reserved
for <n3> tags

« Solution(s):
— Adjust to the new shortcut

— Overwrite the default shortcut with Ctrl+3

« Add Ctrl+3 as the keyboard shortcut for Insert> ColdFusion Objects>
Surround with #

» Create a Surround with # Snippet and add the keyboard shortcut
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Visual authoring with XML data

 Client-side XSL transformation:

— the end user looks at an XML file but sees it nicely
formatted

— requires the XML file is on your own site
— works only in modern browsers

* When using Preview in Browser on an XSL file:
— Dreamweaver generates a flat HTML (using a Temp file)

— the code output is HTML but filled with namespaces and
other extra code

— the output could be saved from the temp file and cleaned up
manually if desired
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Example: Client-Side XSL Transformation

1. File > New > Basic Page > XSLT (Fragment)

2. When the Locate XML Source dialog appears, choose "Attach
a remote file on the internet" and type
http://weblogs.macromedia.com/dev center/index.rdf

as the URL for the XML source.

3. The Bindings panel is populated with a full representation of
the XML file. Drag out the title, create, description and create a
link to Read the article.

4. In Design view, select everything that should repeat

Choose Insert > XSLT Objects > Repeat Region

Choose the rss: item node in the XPath Expression Builder
(Repeat Region) dialog

/. Press F12 to preview

www. cartweaver.com
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XSL Transformation with ColdFusion

ColdFusion Transformation:

1. Beginning with the file from the previous demo, remove the entities from
XSL file. (Entities freak out CF.)

2. Save the XSL file

3. (See next slide for example code.) Explanation of the ColdFusion in simple
terms: Read the XML file in, read the XSL in, and transform it using
ColdFusion

4. Preview it in the Browser
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Example Code: ColdFusion XSL Transformation

e

<cfhttp url="http://weblogs.macromedia.com/dev center/index.rdf"
e Saleel = Hotats e

Sreicteint el DGR e sel s E WS E I e S e

<cfset xslPath = ExpandPath ("mmdesdev.xsl") />

e e =l e et el R e e e
e e
<lpoCwyee il BPOELIC W= ws ) oan sdimve. 10 eeinsa b lomsl /i
"http://www.w3.0rg/TR/xhtmll/DTD/xhtmll-transitional.dtd">
shvemlssxmlyms="YhEame o/ uwpsewis s orep A 9SOyl m] e
<head>

<meta http-equiv="Content-Type" content="text/html; charset=iso-
8859-1"/>

<title>XSL Transformations</title>

</head>

e

<cfoutput>#XMLTransform (xml, xsl)#</cfoutput>
</body>

</html>
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Resources

 Books

— Dreamweaver MX 2004 Killer Tips
by Angela C. Buraglia and Joseph Lowery

Note: There will not be a Dreamweaver 8 Killer Tips
http://www.dwkillertips.com

— Dreamweaver 8 Hands-On-Training by Daniel Short
http://www.amazon.com/exec/obidos/tg/detail/-/0321293894 (coming soon)

* Movies (some free movies available too!)

— Dreamweaver 8 New Features by Garrick Chow
http://movielibrary.lynda.com/html/modPage.asp?ID=173

— All Other Dreamweaver Movies by lynda.com

Includes titles by Daniel Short with new movies coming soon for Dreamweaver 8
http://movielibrary.lynda.com/html/modListing.asp?pid=2
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Resources

* Other Helpful Links

— Dreamweaver 8 Emerging Issues
http://www.macromedia.com/go/a3f38dcf

— The Macromedia Exchange for Dreamweaver
http://www.macromedia.com/exchange/dreamweaver/

— DWfaq's Extension Resource List:
http://www.dwfag.com/resources/extensions/

— Snippets Exchange
http://www.dwfag.com/snippets/
(or try the unforgettable capitalization typo: SnippetSexchange.com
which is really SnippetsExchange.com and goes straight to
dwfaq.com/snippets/)
 Massimo Foti's Snippets Converter

http://www.dwfag.com/Snippets/converter.asp
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Thank you.

Angela C. Buraglia
Email: angela@dwkillertips.com
Blog: http://www.dwmommy.com

Daniel W. Short
Email: dan@site-drive.com
Blog: http://www.dansshorts.com
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